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1. Introducción Tecnología de Gecko Gripper 
 
Gecko Gripper es un dispositivo de agarre para robots que emula la adherencia del geco para 
recoger objetos planos sin un sistema de aire.  
 

1.1. Nomenclatura de Gecko Gripper 
 

 
Imagen 1. Nomenclatura de Gecko Gripper. 

 
El diseño del dispositivo presenta una base estructural que también incluye la electrónica de 
control y de detección. La parte superior de la base estructural es la cara de montaje, que está 
sujeta al robot. En la parte opuesta a la cara de montaje, la cara de agarre presenta cuatro 
almohadillas de sujeción dispuestas en una cuadrícula 2x2 que desempeñan la acción de 
adhesión. Las almohadillas cuentan con una tecnología adhesiva de agarre patentada que 
permite que el dispositivo sujete y levante objetos planos y lisos de manera eficiente sin un 
sistema de aire. Las almohadillas de sujeción son desmontables y se pueden sustituir 
completamente como parte de un plan de mantenimiento rutinario recomendado. La cara de 
agarre también contiene un sensor ultrasónico que controla la presencia de un objeto. La cara 
frontal de la base del dispositivo muestra cuatro LED que indican información sobre el estado 
del dispositivo. Los tres conectores para la alimentación del dispositivo, la comunicación y la 
carga opcional para el sistema autónomo de limpieza piezoeléctrico están situados en la parte 
derecha de la base del dispositivo.  La alimentación (24 V) se suministra a través del conector 
de E/S. Los datos se pasan a través del conector Ethernet (8 pines) o el conector de E/S (10 
pines). 
 



1.2. Cómo funciona Gecko Gripper 
 
Gecko Gripper se adhiere a superficies de objetos planos y lisos a través del mismo 
mecanismo que utiliza un geco real (fuerzas de Van der Waals). Esto se consigue a través del 
contacto con las almohadillas adhesivas de un modo precarga-sujeción-separación.  
 
El dispositivo crea adherencia al precargar las almohadillas con una pequeña fuerza normal 
a la superficie del objeto.  

 
Imagen 2 Colocación de Gecko Gripper sobre el objeto (izquierda) y aplicación de una fuerza de precarga mediante la 

compresión de las almohadillas (derecha). 

 
Tras la precarga, el dispositivo puede sujetar y mover el objeto sin aplicar una fuerza 
adicional.  

 
Imagen 3 El dispositivo es capaz de levantar el objeto. 

Tal como se especifica en el protocolo del robot, el dispositivo se separará del objeto 
mediante la retirada de las almohadillas hacia la carcasa. Las almohadillas de sujeción son 
reutilizables y no dejan manchas de pegamento en las superficies. Se desgastan con el 
tiempo (en función del material del objeto) y se pueden sustituir fácilmente con la 
herramienta de sustitución de la almohadilla. Además, la tecnología de las almohadillas 
similar al geco permite que el dispositivo agarre y se separe en breves espacios de tiempo 
(por ejemplo, 500 ms para una separación).  



 
Imagen 4. Gecko Gripper retrae las almohadillas adhesivas para separarse del objeto. 

 

1.3. Descripción general de los principios operativos clave  
 
Debido al mecanismo de acción único de Gecko Gripper, es importante entender los 
siguientes principios operativos clave para utilizar el dispositivo correctamente y obtener un 
rendimiento de agarre óptimo.  Esto es MUY importante. 

 

• La rugosidad de la superficie afecta al agarre  
Gecko Gripper funciona mejor en superficies muy pulidas que permiten el máximo 
contacto entre las almohadillas adhesivas y la superficie del objeto. Cuanto menos lisa 
sea la superficie, más fuerza de precarga se necesita para agarrar el objeto. Las 
superficies mate deben considerarse el límite máximo de rugosidad que el dispositivo es 
capaz de agarrar.  
Consulte la sección 9.4 para obtener más información. 
 

• Las condiciones del entorno afectan al agarre 
Las almohadillas adhesivas utilizan las fuerzas de Van der Waals para sujetarse al objeto. 
Si hay polvo o residuos en la superficie del objeto, las almohadillas interactuarán con 
estas partículas en su lugar. Una superficie polvorienta, grasienta, aceitosa o mojada no 
se adherirá a Gecko Gripper. El dispositivo funciona mejor en superficies limpias, lisas y 
secas.  
Consulte la sección 9.5 para obtener más información. 

 

• La fuerza de precarga determina la fuerza de carga útil máxima 
La fuerza de adhesión también depende de la cantidad de fuerza de precarga aplicada a 
la superficie. Esta fuerza de precarga también depende de la uniformidad o rugosidad 
de la superficie. Se requiere un umbral mínimo de fuerza de precarga para agarrar y 
mover cualquier carga útil. Por tanto, la fuerza de carga útil se intensifica con un 
aumento correspondiente de la fuerza de precarga. Por último, la fuerza de carga útil 
también es saturable en cierta fuerza de precarga específica de las condiciones 
materiales y operativas.  

 Consulte la sección 9.4 para obtener más información. 
 



• Coordinación entre la función de agarre y la función de detección de colisión del robot 
u otros sistemas de seguridad 
Cuando se utiliza Gecko Gripper con un robot en el control de posición, se debe tener 
cuidado durante la fase de sujeción del objeto para no activar el sistema de detección 
de colisión del robot.  La fuerza máxima que el dispositivo tendrá que ejercer sobre un 
objeto es de 150 N para una adherencia total.  En función del tipo de robot y el objeto, 
es posible que se deba ajustar la configuración de colaboración o de colisión del robot 
para evitar que este se pare al entrar en contacto con el objeto.  

 

• Los momentos del objeto y la posición de este durante la recogida pueden vencer a la 
fuerza de agarre 
Las especificaciones de adhesión del dispositivo asumen que el centro de gravedad del 
objeto es equidistante de las almohadillas del dispositivo. Si el centro de gravedad del 
objeto no está centrado o se aplican momentos al objeto, el movimiento robot-objeto 
puede disminuir la fuerza de adhesión del dispositivo, lo que provoca que el objeto se 
caiga. 

 Consulte la sección 9.5 para obtener más información.  
 

1.4. Cómo funciona el sistema de limpieza piezoeléctrico 
 

Gecko Gripper dispone de un sistema autónomo de limpieza opcional que utiliza la 
piezoelectricidad para limpiar sus almohadillas entre un ciclo de sujeción-separación y el 
siguiente. El controlador del sistema piezoeléctrico estimula a múltiples elementos 
piezoeléctricos unimorfos hasta sus respectivas frecuencias de resonancia (20-26 kHz), lo 
que provoca que la película del sistema geco vibre de forma intensa y se eliminen las 
partículas de polvo de la superficie. El sistema de limpieza piezoeléctrico requiere un 
circuito electrónico adicional dentro de la carcasa del dispositivo que amplifica una tensión 
de entrada hasta 225 V (pico a pico).  
 
Consulte el apéndice sobre el sistema de limpieza piezoeléctrico para obtener más 
información; esta opción no es estándar. 

 

  



2. Seguridad 
 
Gecko Gripper es una pieza de equipo industrial diseñada para ser un efector final o una 
herramienta para robots industriales. Se ha concebido para realizar operaciones de pick & place 
de objetos planos y lisos. El uso inadecuado puede provocar daños en el dispositivo o en el 
equipo al que se conecte.  
 

2.1. Validez y responsabilidad 
 
La información de este manual no es una guía para diseñar una aplicación robótica 
completa. Las instrucciones de seguridad se limitan solo a Gecko Gripper, por lo tanto no 
abarcan las medidas de seguridad de una aplicación completa. La aplicación completa debe 
diseñarse e instalarse de acuerdo con los requisitos de seguridad especificados en las 
normas y los reglamentos del país en el que se instala la aplicación.  
 
Los integradores de la aplicación son los responsables de garantizar que las leyes y los 
reglamentos de seguridad aplicables en el país en cuestión se respeten y de eliminar 
cualquier riesgo significativo en la aplicación completa.  
 
Esto incluye, a título enunciativo, lo siguiente:  

• Realizar una evaluación de riesgo para la aplicación completa. 
 

• Validar que la aplicación completa esté diseñada e instalada correctamente.  
 
 

2.2. Limitaciones de responsabilidad 
 

Las instrucciones de seguridad y otra información de este manual no son una garantía de 
que el usuario no va a sufrir una lesión, incluso si se siguen todas las instrucciones.  
 
 

2.3. Advertencias que figuran en este manual 
 

PELIGRO: Indica una situación muy peligrosa que, de no evitarse, podría causar 
lesiones o la muerte.  

 
PRECAUCIÓN: Indica una situación potencialmente peligrosa que, de no evitarse, podría 

causar lesiones o daños al equipo.  
 
AVISO: 
 Indica información adicional, como consejos o recomendaciones.  

 
 
 



2.4. Advertencias generales  
 
Esta sección contiene advertencias generales acerca del uso de Gecko Gripper. 
 

1. Asegúrese de que el dispositivo esté correctamente montado. 
 

2. Asegúrese de que el dispositivo no choca con obstáculos. 
 

3. Nunca utilice un dispositivo dañado. 
 

4. Asegúrese de que ninguna extremidad esté en contacto con la carcasa o la cara de 
montaje del dispositivo cuando está en funcionamiento o en el modo de 
aprendizaje. 
 

5. Asegúrese de seguir las instrucciones de seguridad de todos los equipos utilizados en 
la aplicación. 
 

6. ¡Nunca modifique el dispositivo! Una modificación podría provocar situaciones 
peligrosas. 
 

7. OnRobot A/S RENUNCIA A TODA RESPONSABILIDAD SI EL PRODUCTO SE CAMBIA O 
SE MODIFICA DE CUALQUIER FORMA. 

 
8. Al montar un equipo externo asegúrese de que se sigan las instrucciones de 

seguridad tanto de este documento como del manual externo. 
 

9. Si el dispositivo se utiliza en aplicaciones en las que no está conectado a un robot 
UR, es importante asegurarse de que las conexiones se asemejen a la entrada 
analógica, las entradas digitales, las salidas y las conexiones de alimentación. 
Asegúrese de utilizar un script de programación de Gecko Gripper que esté 
adaptado para adecuarse a su aplicación específica. Si desea obtener más 
información, póngase en contacto con su proveedor. 

 
10. Cuando el dispositivo se combina o trabaja con máquinas que puedan dañarlo, se 

recomienda encarecidamente probar todas las funciones por separado fuera del 
espacio de trabajo potencialmente peligroso. 
 

11. Cuando la respuesta del dispositivo (señal de E/S lista) sea necesaria para continuar 
la operación y un mal funcionamiento cause daños en el dispositivo o en otras 
máquinas, se recomienda encarecidamente utilizar sensores externos, además de la 
respuesta del dispositivo, para asegurar un funcionamiento correcto incluso si se 
produce un fallo. OnRobot A/S no se hace responsable de los daños causados al 
dispositivo o a otro equipo debido a errores de programación del dispositivo. 
 

12. Nunca deje que el dispositivo entre en contacto con sustancias corrosivas, 
salpicaduras de soldadura o polvos abrasivos, ya que pueden dañarlo.  



 
13. Tenga en cuenta las normas colaborativas si el personal se encuentra dentro del 

rango operativo del dispositivo. 
 
14. Nunca maneje el dispositivo si la máquina en la que está instalado no cumple con las 

leyes y normas de seguridad de su país. 
 
 

2.5. Uso previsto 
 
El dispositivo es un equipo industrial diseñado para ser un efector final o una herramienta 
para robots industriales. Se ha concebido para realizar operaciones de pick & place de una 
gran variedad de objetos. 
 
El uso colaborativo del dispositivo con personas cerca de la zona de trabajo o en ella solo 
está destinado a aplicaciones no peligrosas, donde la aplicación completa, incluido el 
objeto, no comporta riesgos significativos de acuerdo con la evaluación riesgos de la 
aplicación específica. 
 
Cualquier uso o aplicación que se desvíe del uso previsto se considera uso incorrecto 
inadmisible. Esto incluye, a título enunciativo, lo siguiente: 

1. El uso en ambientes potencialmente explosivos.  
2. El uso en aplicaciones críticas en un contexto médico o vital.  
3. El uso antes de realizar una evaluación de riesgos. 

 
 

2.6. Evaluación de riesgos 
 
Es importante hacer una evaluación de riesgos. Puesto que el dispositivo se considera una 
máquina parcialmente completa, también es importante seguir las instrucciones de los 
manuales de todos los equipos adicionales utilizados en la aplicación. OnRobot A/S 
recomienda que el integrador utilice la normas ISO 12100 y ISO 10218-2 para llevar a cabo 
la evaluación de riesgos. 
 
El integrador debe tener en cuenta las siguientes situaciones potencialmente peligrosas 
cuando realice la evaluación de riesgos. Pueden surgir situaciones peligrosas adicionales en 
función de la condición o aplicación específica. 

1. Compresión de las extremidades entre el dispositivo y el objeto. 
2. Penetración de la piel con bordes y puntas afiladas en el objeto agarrado. 
3. Consecuencias debidas al montaje incorrecto del dispositivo. 
4. Objetos que se caen del dispositivo debido, por ejemplo, a una fuerza de agarre 

incorrecta o a una aceleración elevada de un robot. 
 

  



3. Guía de inicio: Contenido 
3.1. Gecko Gripper 

 
Imagen 5 Dibujo de CAD de Gecko Gripper y las almohadillas. 



 

3.2. Listado de piezas y números de pieza  
 

Nombre de la pieza Descripción 

Gecko Gripper V5 
Gecko Gripper versión 5, con sistema 
de limpieza piezoeléctrico 

Conjunto de cuatro 
almohadillas de Gecko 
Gripper sin sistema de 
limpieza piezoeléctrico 

Conjunto de cuatro almohadillas de 
Gecko Gripper sin sistema de limpieza 
piezoeléctrico 

Cable Turck, 10 hilos, E/S 

Cable, 10 hilos, doble terminación 
(conector hembra recto y conector 
macho recto), conectores M12 Eurofast 

Cable Turck, 8 hilos, 
Ethernet RJ45 

Cable, 8 hilos, Ethernet, Macho, M12 
de 5 m 

Pernos de montaje para el 
dispositivo 

Tornillo Allen de acero inoxidable, 
M6X1.0 y 80 mm de longitud 

Llave Allen para montaje 
del robot, 5 mm, 9 
pulgadas de longitud total 

Llave Allen para montaje del robot, 5 
mm, 9 pulgadas de longitud total 

Herramienta de extracción 
de almohadillas 

Espátula con borde biselado, ancho de 
hoja 1-1/4" y grosor 0,075" 

Unidad USB OnRobot A/S 
con guías e interfaz gráfica 
de usuario 

Memoria USB con guías e interfaz 
gráfica de usuario 

ADAPTADOR DE 
CORRIENTE AC/DC de 24 V 
y 90 W 

ADAPTADOR DE CORRIENTE AC/DC de 
24 V y 90 W 

Guía de inicio rápido  
 

Tabla 1 Listado de piezas de Gecko Gripper y adiciones opcionales. 

 
 
 
 
 
 

3.3. Software de Gecko Gripper 
 

El software de interfaz de usuario para configurar y operar Gecko Gripper se puede 
descargar desde la memoria USB de OnRobot A/S que se adjunta o bien desde la página 
web de OnRobot A/S: 

 
https://onrobot.com/products/gecko-gripper/ 

  

https://onrobot.com/products/gecko-gripper/


4. Guía de inicio rápido  
 

Recordatorios de seguridad 
La instalación y las operaciones de Gecko Gripper deben ser realizadas únicamente 
por profesionales capacitados. 
 
PELIGRO: La manipulación inadecuada del dispositivo y de sus piezas 

mientras está conectado podría causar lesiones o la muerte. 
 

PASO 1: Instalar las almohadillas y montar el dispositivo  
Instale las cuatro almohadillas de sujeción de Gecko Gripper insertándolas en la 
cara de agarre del dispositivo. Gecko Gripper utiliza dos tornillos (M6-1-80) para 
ensamblarse directamente a un robot de Universal Robots. Para otras marcas de 
robots, se debe utilizar una placa de montaje. Utilice la llave Allen de 5 mm para 
insertar y apretar los tornillos a 8 Nm.  

 
 

PASO 2:  Conectar el dispositivo a la alimentación  
Gecko Gripper se alimenta a través del cable de E/S. El sistema de limpieza 
piezoeléctrico autónomo requiere una conexión adicional a una fuente de 
alimentación de alto voltaje a través del cable piezoeléctrico. 

 
Al encender el dispositivo, la luz de comunicación de color azul del mismo 
parpadeará dos veces después de una breve espera para indicar que el 
dispositivo ha completado su secuencia de encendido. Se recomienda que 
pruebe ahora todas las funciones del dispositivo mediante la interfaz gráfica de 
usuario para Windows. 

 
 
PASO 3: Instalar la interfaz gráfica de usuario de Gecko Gripper  

Instale la interfaz de Gecko Gripper para Windows descargándola desde la 
memoria USB que se adjunta o bien desde la página web de OnRobot A/S. 

 
 

PASO 4:  Establecer los parámetros del dispositivo 

Recomendamos el uso de la interfaz independiente del robot para probar la 
funcionalidad de agarre y programar el dispositivo. Esta interfaz fácil de usar le 
permite especificar una serie de parámetros que determinan el estado del 
dispositivo. 

 
 

PASO 5:  Manejar el dispositivo 
Puede manejar Gecko Gripper a través de dos modos diferentes de 
comunicación: E/S digital y Ethernet TCP. Mediante estos modos puede crear un 
protocolo de agarre totalmente personalizado y adaptado a sus necesidades.  



5. Instalación del dispositivo en el robot  
 
Montar el dispositivo en el robot es un proceso rápido y sencillo. En el caso de todos los 
modelos de Universal Robots, el dispositivo se puede montar directamente en el robot y no 
requiere de la placa de montaje. Para otros modelos de robot, es necesaria una placa de 
montaje u otro adaptador. 
 

5.1. Materiales, herramientas y equipos necesarios 
 

Monte los siguientes materiales, herramientas y equipos antes de la instalación: 
 

Piezas 
Componentes del dispositivo 

✓ Gecko Gripper V5 
✓ Conjunto de almohadillas de Gecko 

Gripper 
✓ Cable Turck, 10 hilos, E/S 
✓ Cable Turck, 8 hilos, Ethernet RJ45 
✓ Pernos de montaje para el dispositivo 

(M6-1-80) 
✓ Unidad USB de OnRobot A/S con las 

guías y la interfaz gráfica de usuario 

Materiales 
Fungibles 

✓ Bridas (recomendado) 
✓ Placa de montaje para modelos de 

robot alternativos (opcional) 

Herramientas 
Necesarias para la instalación o la 
reparación, pero no para el manejo. 

✓ Llave Allen de 5 mm (incluida) 
✓ Herramienta de extracción de 

almohadillas (incluida) 
 

Equipos 
Necesarios para el manejo. 

✓ Adaptador de corriente AC/DC de 24 V y 
90 W (incluido) 

✓ Fuente de alimentación DC de 24 V 
✓ Fuente de alimentación de alta tensión 

para el sistema de limpieza 
piezoeléctrico opcional   

Tabla 2 Materiales para la instalación.  

 



5.2. Instalación mecánica: Montaje del dispositivo 
 

5.2.1. Listado de piezas  
Las siguientes piezas se incluyen con Gecko Gripper: 

✓ Gecko Gripper 
✓ Conjunto de almohadillas de Gecko Gripper 
✓ Tornillos de montaje (2) 
✓ Llave Allen de 5 mm (para el montaje del dispositivo) 

 
 
 

5.2.2. Advertencias de seguridad:  
 
PELIGRO:  La instalación incorrecta puede provocar daños en el 

dispositivo, el robot o los materiales, y lesionar a los 
operarios e incluso provocar la muerte. Asegúrese de que el 
dispositivo ha sido correctamente instalado por un profesional 
capacitado. 

 
PRECAUCIÓN: Asegúrese de que el robot está apagado o parado (no hay ningún 

programa en ejecución) antes de instalar el dispositivo. 
 

5.2.3. Procedimiento para el montaje del dispositivo 
 
En el caso de los robots de Universal Robots, continúe hasta el paso 2, ya que no se 
requiere ninguna placa de montaje. 
 
Paso 1: Instale las almohadillas en el dispositivo antes de instalar el dispositivo en 

el robot.  
 



 
Imagen 6 La cara de agarre de Gecko Gripper donde se insertarán las cuatro almohadillas. 

 
Fije las cuatro almohadillas de Gecko Gripper a la cara de agarre 
alineando la hendidura del orificio de montaje con su pestaña 
correspondiente del conjunto de almohadillas.  
 

 
Imagen 7 Hendidura del orificio de montaje (izquierda) y pestaña en el conjunto de almohadillas 

(derecha). 



 
 
 

 
Imagen 8 Alineación del conjunto de almohadillas para insertarlas en el agujero de montaje. 

 
 
Los imanes potentes del sistema de fijación de la almohadilla ayudarán a 
colocar las almohadillas en su lugar. Una vez instaladas, deben estar 
completamente alineadas con la superficie de la cara de agarre del 
dispositivo.  
 

 
Imagen 9 Instalación de última almohadilla en el dispositivo. Observe que la placa plateada de las almohadillas 

instaladas está alineada con la base del dispositivo. 



 
Paso 2: Fije la placa de montaje al robot utilizando los dos tornillos de montaje 

(M6-1-80). Apriete cada tornillo a 8 Nm con una llave Allen de 5 mm.  
Este paso solo es necesario para las marcas que no son Universal Robots. 

 

 
Imagen 10 Placa de montaje para robots que no son de Universal Robots. 

  
 

Paso 3: Alinee los orificios de la cara de montaje de Gecko Gripper con los 
orificios de montaje del robot (o con la placa de montaje o adaptador 
medida).  

 

 
Imagen 11 Los dos orificios de montaje de la cara de montaje del dispositivo. 

  



Inserte cada tornillo de montaje (M6-1-80) en la parte frontal del 
dispositivo, por el tubo de paso, y utilice la llave Allen de 5 mm que se 
adjunta para atornillarlos en su sitio. Apriete cada tornillo a 8 Nm con la 
llave Allen de 5 mm. 

 

 
Imagen 12 Apriete los tornillos de montaje para fijar el dispositivo al robot utilizando la llave Allen de 5 mm. 

 
El punto central de la herramienta Gecko Gripper no tiene desplazamiento de ejes X 
o Y con respecto al robot. Por lo tanto, el punto central de la herramienta se 
encuentra a 185 mm (dirección del eje z) de la cara de montaje del brazo robótico.  
Consulte la sección 9.1 para obtener más información sobre las dimensiones del 
dispositivo.  

 
Ya puede conectar los cables del dispositivo montado (sección 6.3).  

 
 

5.3. Instalación eléctrica: Encendido y comunicación con el dispositivo 
 

5.3.1. Especificaciones de la fuente de alimentación 
 
El propio Gecko Gripper se alimenta a través del cable E/S. Los hilos sueltos en el cable 
que se proporciona tendrán que conectarse a la fuente de alimentación adaptada a sus 
necesidades. Esto puede incluir la conexión a:  

• Una fuente de alimentación externa DC de 24 V, 48 W (nominal; máximo 28 V) a 
través del conector cilíndrico que se incluye. 

• La fuente de alimentación DC de 24 V integrada del controlador del robot. 
 
El sistema autónomo de limpieza piezoeléctrico de Gecko Gripper (opcional) requiere 
una segunda fuente de alimentación de alta tensión.  



• Consulte el apéndice sobre el sistema de limpieza piezoeléctrico para obtener 
más información. 

 

5.3.2. Comunicaciones 
 
En función de sus necesidades de alimentación y comunicación, existen dos 
configuraciones de cable posibles (que incluyen el sistema de limpieza autónomo): 

• Alimentación y comunicación mediante E/S digital (1 cable). 

• Alimentación mediante E/S digital y comunicación mediante Ethernet TCP/IP (2 
cables). 

 
El sistema de limpieza piezoeléctrico opcional requiere un cable adicional de 4 pines.  

 
E/S digital 
✓ Comunicación y alimentación de 24 V a través de un conector de 10 pines (el 

conector de 8 pines no se utiliza para la comunicación de E/S digital, solo en 
el caso de Ethernet; véase a continuación). 

✓ Puede controlarse mediante cualquier tipo de robot con las señales de E/S 
simples. 

✓ Los puntos de ajuste deseados (por ejemplo, las especificaciones sobre 
control de posición, fuerza, precarga, etc.) se configuran por primera vez a 
través de la interfaz para Windows; después, el dispositivo se controla por 
medio de la interfaz de E/S. 

✓ No es necesario instalar ningún software del robot. 
 

Puede conectar Gecko Gripper a la alimentación de una de las siguientes formas 
mediante E/S: 
1. Conectando el conector jack cilíndrico directamente a la fuente de 

alimentación que se incluye.  
2. Desconectando el conector jack cilíndrico y utilizando una fuente de 

alimentación de 24 V en el controlador de robot que prefiera (u otra fuente). 
Gecko Gripper consume menos de 1 amperio (pico y RMS). 

 
El cable de E/S digital se suministra con puertos para conectarlo al dispositivo y a 
los cables flexibles del extremo opuesto, para un cableado directo y a medida 
según sea necesario con objeto de integrarlos a su sistema.  

 



 
Imagen 13 Terminal de cable E/S digital con conector jack cilíndrico (para conectar directamente a la fuente de alimentación) y 

otros cables de entrada/salida. 

Para el cableado de los canales de E/S a sus conexiones adecuadas, consulte la 
sección 8.1 sobre comunicaciones digitales E/S. 
 

Ethernet  
✓ Comunicación a través del conector de 8 pines. 
✓ Puede controlarse a través de las interfaces a medida de las consolas de 

programación de Universal Robots, Kawasaki y FANUC.  
✓ También se puede controlar con la interfaz gráfica de usuario para Windows, 

mediante conexión directa Ethernet entre el ordenador y el dispositivo. 
 

La comunicación por Ethernet permite el ajuste dinámico de los parámetros del 
dispositivo, mientras que en el caso de E/S dichos parámetros no se pueden ajustar de 
forma dinámica sin la interfaz para Windows.  

 

5.3.3. Procedimiento para la alimentación y cableado del dispositivo  
 
Después de montar el dispositivo en el robot (sección 6.2) e identificar la fuente de 
alimentación adecuada, ya se pueden conectar los cables del dispositivo.  
 
Necesitará los cables de alimentación y de comunicación que se proporcionan con el 
dispositivo (cable Turck, 10 hilos, E/S, y cable Turck, 8 hilos, Ethernet RJ45), así como 
varias bridas o un material similar para sujetar los cables de modo que la amplitud total 
de movimiento del robot no interfiera en ellos. 
 

PRECAUCIÓN:  Asegúrese de verificar la integridad de los conectores de la base 
del dispositivo, ya que los pines se pueden doblar y dañar fácilmente.  

 
Paso 1: Conecte el cable de alimentación y E/S digital al conector 

correspondiente situado en la base del dispositivo.  
 



 
Imagen 14 Conexión del cable de alimentación y E/S digital al conector correspondiente del dispositivo. 

 
Paso 2: Si utiliza la comunicación por Ethernet, conecte el cable Ethernet al 

conector correspondiente situado en la base del dispositivo. 
 

 
Imagen 15 Conexión del cable Ethernet al conector correspondiente en la base del dispositivo. 

 
Paso 3: Tire el cable desde el dispositivo y páselo por el robot hasta la fuente de 

alimentación y el controlador.  



Asegúrese de que deja suficiente holgura en los cables para que no estén 
en tensión durante la amplitud total de movimiento del robot.  
 

 
Imagen 16 Los cables recorren de forma holgada el brazo del robot. 

 
Paso 4: Asegure los cables de manera que se mantengan apartados y fuera del 

rango de movimiento del robot y del objeto. Realice todos los 
movimientos posibles del robot para garantizar que los cables no resulten 
dañados durante el funcionamiento (véase el ejemplo de rotación del J-6 
a continuación). 

 

 
Imagen 17 Rotación del J-6 en la que los cables de alimentación y de comunicaciones no resultan dañados por el 

movimiento del robot. 

 
 Se recomienda el uso de bridas; sin embargo, otros adhesivos o elementos 

de fijación pueden resultar más adecuados para sus necesidades 
particulares. 

  
AVISO:  En función de su protocolo o sus condiciones de funcionamiento, puede 

plantearse la adición de otra protección estructural o aislante para los 
cables. 

 
 



5.3.4. Indicadores LED de estados eléctricos y de comunicación 
 
La base de Gecko Gripper tiene pilotos LED que proporcionan información visual rápida 
sobre la situación de cuatro estados diferentes. 
 
Los indicadores LED y su significado se muestran en la siguiente tabla: 

Nombre del LED 
y color 

Color fijo Parpadeo lento Parpadeo rápido 

POWER 
Verde 

Alimentación 
conectada 

N/A N/A 

ERROR  
Rojo 

N/A Advertencia (errores 
internos): el dispositivo 
necesita mantenimiento. 
Compruebe el registro de 
errores para obtener más 
información. 

Error grave: el dispositivo 
debe detenerse 
inmediatamente e 
investigarse. 

PAD 
(almohadilla) 
Naranja 

N/A Una pieza se ha caído. Las piezas se han caído 
varias veces y se ha 
actualizado el registro de 
errores. 

COMMS 
(comunicaciones) 
Azul 

Comunicaciones 
conectadas 

N/A N/A 

Imagen 3 Tabla de indicadores LED y su significado. 

 

Después de conectar los cables de alimentación y de comunicación entre el dispositivo y 
su fuente de alimentación y el controlador, compruebe que los LED de la base del 
dispositivo indican que el funcionamiento es correcto: verde fijo, azul fijo y no hay luces 
de color rojo o naranja. 
 



 
Imagen 18Los LED indican que el dispositivo funciona de forma correcta (el verde fijo de la alimentación, POWER; el azul fijo de 

las comunicaciones, COMMS; y los LED de errores, ERROR, y de almohadillas, PAD, están apagados). 

 

5.4. Notas de instalación para los diferentes tipos de robots 
 
Para obtener información adicional de instalación sobre las diferentes marcas de robots, 
consulte el sitio web de OnRobot A/S para Gecko Gripper: 
 

https://onrobot.com/products/gecko-gripper/ 
  

https://onrobot.com/products/gecko-gripper/


6. Configuración de los parámetros del dispositivo 
 
Puede crear un protocolo de agarre totalmente personalizado y adaptado a las especificaciones 
de su protocolo mediante la interfaz de usuario gráfica de Gecko Gripper, en la que puede 
especificar la fuerza e precarga del dispositivo y los puntos de ajuste del rango ultrasónico, y 
guardar varios estados del dispositivo para un futuro uso. 
  

6.1. Instalación de la interfaz gráfica de usuario para Windows 
 

OnRobot A/S ofrece una interfaz para sistemas operativos Windows para programar y 
controlar Gecko Gripper mediante un cable Ethernet.  

 
Requisitos de software recomendados: 
✓ Instalación de Windows 7 con Service Pack 1 o superior (versión x86 o x64) 
✓ Instalación de Microsoft .NET Framework 4.7 o superior 
 

6.1.1. Instalación de la interfaz gráfica de usuario para ordenador:  
 

Paso 1: Instale la aplicación abriendo el archivo «Gecko Gripper Desktop GUI setup» 
que se encuentra en la memoria USB que proporciona OnRobot A/S o 
descárguelo desde la página web de OnRobot A/S. 

 

 
Imagen 19 Comienzo de la instalación de la interfaz de Gecko Gripper. 

 



Paso 2:  Seleccione la casilla de verificación para iniciar la interfaz gráfica de usuario 
cuando se complete la instalación. Esto iniciará la aplicación. 

 

 
Imagen 20 Inicio de la interfaz de Gecko Gripper tras la instalación. 

Ya puede iniciar la aplicación en cualquier momento abriendo el ejecutable 
«PerceptionRobotics.GeckoWpfClient.exe» desde la carpeta en la que se instaló. 
 
Paso 3:  Introduzca la dirección IP de Gecko Gripper cuando se le solicite en la 

pantalla de inicio para permitir la comunicación con el dispositivo.  

 
Imagen 21 Pantalla de inicio de Gecko Gripper. 



 
También puede cambiar la configuración del puerto o la IP en la pestaña 
«Settings» (Configuración) en la barra del menú principal. La dirección IP por 
defecto del dispositivo es 192.168.0.170 y el número de puerto 
predeterminado es 30000. 
 

Seleccione la opción «Save as Default» (Guardar como predeterminado) para 
utilizar automáticamente esta dirección IP para Gecko Gripper la próxima vez 
que abra la aplicación. 
 

6.2. Configuración de la IP estática para la interfaz  
 
Gecko Gripper y el ordenador de sobremesa deben compartir la misma red local para 
comunicarse correctamente. En los siguientes pasos se detalla cómo se configura la 
dirección IP de escritorio para emparejarla con la de Gecko Gripper. 

 
Paso 1:  Abra el Panel de control y haga clic en «View network status and tasks» (Ver el 

estado y las tareas de red). 

 
Imagen 22 Localización del estado de la red en el panel de control del ordenador (resaltado en azul). 

 
Paso 2: Haga clic en «Change adapter settings» (Cambiar configuración del adaptador) 

en el panel superior izquierdo de la ventana. 



 
Imagen 23 Localización del enlace «Change adapter settings» (Cambiar configuración del adaptador) (texto azul subrayado). 

 
Paso 3: En la siguiente ventana, haga clic con el botón derecho en «Ethernet» para abrir 

un menú desplegable y seleccione «Properties» (Propiedades). 

 
Imagen 24 Acceso a la opción del menú «Properties» (Propiedades) de Ethernet. 

Paso 4: En el menú emergente Propiedades de Ethernet, busque y seleccione «Internet 
Protocol Version 4 (TCP/IPv4)» (Protocolo de Internet versión 4). Cuando lo haya 
seleccionado, haga clic en el botón «Properties». 



 
Imagen 25 Acceso a Propiedades para la opción «Internet Protocol Version 4 (TCP/IPv4)». 

Paso 5: En la ventana emergente que aparece, seleccione el botón de opción «Use the 
following IP address» (Usar la siguiente dirección IP).  

 
 En el cuadro de «IP address» (Dirección IP), introduzca «192.168.0.X», donde X 

es cualquier número entero entre 0 y 255 distinto de 170, porque 
“192.168.0.170” es la dirección IP de Gecko Gripper. Por ejemplo, «192.168.0.3» 
es una dirección IP válida para la interfaz que permitirá la comunicación con 
Gecko Gripper (véase la imagen). 

 
En el recuadro llamado «Subnet mask» (Máscara de subred), introduzca 
«255.255.255.0». 
 
Deje el recuadro «Default gateway» (Puerta de enlace predeterminada) vacío.  
 
Haga clic en «OK» (Aceptar) para finalizar la asignación de la dirección IP a la 
interfaz gráfica, la cual ya puede localizar Gecko Gripper y conectarse con él. 

 
 



 
Imagen 26 Introducción de una dirección IP válida para la interfaz. 

6.3. Configuración de los parámetros del dispositivo mediante la interfaz gráfica de 
usuario para Windows 

 
Cuando se establece correctamente una conexión con Gecko Gripper, aparece la pantalla 
del modo de formación. Tenga en cuenta que puede desconectar el dispositivo en cualquier 
momento si selecciona la opción «Disconnect» (Desconexión) de la barra del menú. 

 

 
Imagen 27 Pantalla del modo de formación (Crear nuevo estado) en la interfaz para ordenador. 

 
 Compruebe que el software de la interfaz Gecko Gripper está actualizado. La 

versión de software aparece en la página «About» (Acerca de), debajo de 
«Help» (Ayuda) en la barra del menú principal. 



 

 
Imagen 28 Cuadro de diálogo «About» (Acerca de). 

Para obtener información sobre la solución de problemas y la asistencia, 
haga clic en «Support» (Asistencia) en la pestaña «Help» (Ayuda) de la barra 
del menú principal. 

 
 Puede configurar las unidades de medida deseadas (sistema métrico o 

imperial o porcentaje) en la pestaña «Settings» (Configuración) en la barra 
del menú. 

 
Imagen 29 Cambio de unidades de medida dentro del cuadro de diálogo «Settings» (Configuración). 

Ahora ya puede verificar la funcionalidad del dispositivo y configurarlo desde el 
ordenador. 

 

6.3.1. Creación de un nuevo estado: Programación de una función de agarre por 
primera vez 

Paso 1: Abra la aplicación Gecko Gripper. Aparecerá la pantalla «Training Mode» 
(Modo de formación). 



 
Imagen 30 Pantalla del modo de formación (Crear nuevo estado). 

 

Paso 2: Seleccione el modo de comunicación y el robot adecuados en el menú 
desplegable «Robot» en la parte central de la interfaz. 

 
Paso 3: Ajuste la fuerza de precarga deseada.  

Este ajuste modifica el nivel de fuerza con el que el dispositivo notifica al 
robot que se ha alcanzado una cierta carga. Por ejemplo, al agarrar una 
pieza grande de vidrio para la que se requiere una fuerza de precarga de 
100 N, cuando se alcanza 100 N en el modo E/S, el pin 5 se establece en 
HIGH (alto); en el modo Ethernet, el índice de paquete 9 se establece de 
0 a 1.  
Consulte la sección 9.4 para obtener más información sobre cómo 
seleccionar una fuerza de precarga adecuada para la tarea y el material.  
 
NOTA: El rango de detección de precarga de Gecko Gripper es de 30 a 150 
N. No se puede detectar por debajo de 30 N. 
 

Paso 4: Ajuste el rango ultrasónico.  
Al igual que la configuración de la fuerza de precarga, esta configuración 
notifica al robot el rango en que se alcanza la fuerza de precarga 
designada. Esta característica es útil para recoger objetos planos de una 
pila, ya que permite al programador del robot ejecutar el robot a 
velocidad máxima hasta que el dispositivo detecta que se está acercando 
a un punto de recogida. En el paso 2 de la sección 8.1 se describe un 
ejemplo práctico de este uso. 

  El rango ultrasónico por defecto es de 125,0 mm. 
 

Paso 5: Seleccione la posición de las almohadillas.  



Para probar la funcionalidad básica de sujeción, el usuario puede probar y 
realizar una acción con cada posición de la almohadilla («Engage» y 
«Disengage», sujeción y separación). 

 La posición de la almohadilla por defecto es «engage» (sujeción). 
 
Paso 6: Una vez haya finalizado la configuración del nuevo estado, seleccione 

«Perform Action» (Realizar acción) para configurar el dispositivo en el 
estado que coincida con los parámetros seleccionados.  
Estos parámetros se graban en la memoria del dispositivo. Si el 
dispositivo se ejecuta en la configuración de E/S, se hará referencia a 
estos parámetros para establecer el estado del dispositivo. Si el 
dispositivo se utiliza en el modo Ethernet, se hará referencia a estos 
parámetros como estado inicial, pero se pueden modificar de forma 
dinámica.  

 
Paso 7: Para mostrar la fuerza de agarre y los datos de posición del dispositivo en 

tiempo real, seleccione “Start Plotting Data” (Iniciar trazado de datos). 
Para detener la presentación de datos, seleccione “Stop Plotting Data” 
(Detener trazado de datos). 

 
Imagen 31 Trazado de datos de agarre en la interfaz. 

Paso 8: Para ver los datos de agarre en tiempo real, incluida la presencia de 
piezas, el deterioro, la fuerza de precarga y la posición de la almohadilla, 
diríjase a «View Data» (Ver datos), que se encuentra debajo de la pestaña 
«Data» (Datos) en la barra del menú. 



 

    
Imagen 32 Datos de agarre en la interfaz para ordenador. 

 
 

 
Acciones adicionales: 
  Guardar configuración de agarre (véase la sección 7.3.2) 

Cargar una configuración de agarre actual (véase la sección 7.3.3) 
Restablecer dispositivo (véase la sección 7.3.4) 
Tratamiento de errores (véase la sección 7.3.5) 
Limpieza de almohadillas (véase la sección 7.3.6) 
 

 

6.3.2. Guardar configuración de agarre 
 

Si desea utilizar varias configuraciones de parámetros, puede serle de utilidad 
guardar las configuraciones individuales en un archivo y acceder a ellas en otro 
momento. Esta característica es útil si se van a agarrar varios objetos y es necesario 
volver a asignar tareas al robot de forma periódica.  

 
Paso 1: Seleccione «File → Save Action to File» (Archivo → Guardar acción en un 
archivo) en la barra del menú. 

 
Debe decidir, a través de un cuadro de diálogo, si desea guardar los 
parámetros de estado en un archivo XML. 



 
Imagen 33 Guardado de un archivo XML con los parámetros de Gecko Gripper. 

 

6.3.3. Carga de una configuración con un estado existente o previamente guardado 
 
Si tiene varias configuraciones de sujeción guardadas, puede cargarlas para vincular 
rápidamente un dispositivo a un estado ya utilizado. 
 
Paso 1: Seleccione «File → Load Configuration» (Archivo → Cargar configuración) 
en la barra del menú. 
  Aparecerá un cuadro de diálogo para abrir el archivo. 
 



 
Imagen 34 Uso de la interfaz para abrir un archivo XML con una configuración de sujeción guardada previamente. 

 
Paso 2: Seleccione abrir un archivo XML guardado previamente. 

Esto cargará los ajustes para el estado de Gecko Gripper guardados 
dentro de ese archivo y volverá a la pantalla del modo de entrenamiento 
(carga del estado).  
 

 

Imagen 35 Pantalla del modo de formación (carga del estado) con los parámetros de un estado previamente guardado. 

 



Paso 3: Seleccione «Perform Action» (Realizar acción) para accionar el dispositivo 
con el estado cargado en el paso anterior.  

 

6.3.4. Restablecimiento del dispositivo  
 
Esta acción restablece todos los cambios realizados en los parámetros de estado de 
sujeción desde la última vez que se guardaron en el archivo XML asociado. Si no 
existen versiones guardadas previamente, al restablecer el dispositivo se revierten 
los parámetros de sujeción a los valores por defecto (véase la sección 8). 
 
Paso 1: Vaya a la pantalla del modo de formación a partir de un nuevo estado o 

bien después de seleccionar «Load Existing State» (Cargar estado 
existente). 

 
Paso 2: Haga clic en el botón «Reset Gripper» (Restablecer dispositivo) situado en 
la parte inferior izquierda de la pantalla. 

 
 

6.3.5. Tratamiento de errores 
 
La interfaz de Gecko Gripper guarda información detallada acerca de los eventos o 
errores inesperados durante la ejecución del programa. Estos registros de errores se 
pueden recuperar haciendo clic en «Error Logs» (Registro de errores) en la barra del 
menú «Help» (Ayuda). Haga clic en «Load Logs» (Cargar registro) para ver la 
información del registro de errores. El registro de errores se puede guardar en un 
archivo para que sirva de ayuda en la resolución de problemas. Para borrar todos los 
registros que figuran en la pantalla, haga clic en «Clear All» (Borrar todo). Seleccione 
«Cancel» (Cancelar) para volver a la pantalla del modo de formación. 
 



 
Imagen 36 Detalles del registro de eventos y errores. 

 
 

6.3.6. Limpieza de almohadillas 
 

La función «Clean Pads» (Limpieza de almohadillas) se utiliza con el sistema 
autónomo de limpieza piezoeléctrico opcional. 
 
Consulte el apéndice sobre el sistema de limpieza piezoeléctrico para obtener más 

información.  
 
  



7. Manejo del dispositivo 
 
Los protocolos para el manejo del dispositivo dependerán en gran medida del modo de 
comunicación: E/S digital o Ethernet TCP. En las comunicaciones a través de Ethernet se puede 
transferir bastante más información. Las condiciones de funcionamiento adicionales para las 
marcas específicas de robots se pueden encontrar en los apéndices ubicados en el sitio web de 
Gecko Gripper de OnRobot A/S.  
 
El dispositivo realiza las siguientes tareas principales, que se pueden accionar a través de 
cualquier modo de comunicación:   

• Sujeción  

• Separación 

• Uso del sistema de limpieza de las almohadillas (véase el apéndice sobre el sistema de 
limpieza piezoeléctrico). 

 

7.1. Comunicación a través de E/S digital  
 
En esta sección se detalla la forma de manejar el dispositivo para realizar tareas específicas 
utilizando la comunicación con E/S digital. 
 
AVISO: Recomendamos el uso de la interfaz para Windows si se opta por la 

comunicación con E/S digital para manejar el dispositivo. Utilizar la interfaz 
para programar es fundamental para emplear todas las funciones del 
dispositivo. 

 
Paso 1: Utilice la interfaz bajo Windows para configurar los valores de los siguientes 

puntos de ajuste (véase la sección 7 para obtener más información): 

• Precarga 

• Rango ultrasónico 

• Posición de las almohadillas 

• Tiempo de limpieza (si la opción está instalada) 
 

Cuando el dispositivo se controla mediante E/S, su comportamiento viene 
determinado por los parámetros guardados en la memoria del mismo. Los 
parámetros del dispositivo se guardan en la memoria solo cuando está 
seleccionada la opción «Perform Action» (Realizar acción) en la pantalla del 
modo de formación de la interfaz.  En el control por E/S, los parámetros son 
estáticos, pero se puede acceder a los datos de comportamiento y del sensor del 
dispositivo a través del control por E/S. 

 
Paso 2: Utilice el robot para controlar el dispositivo en modo E/S. La disposición de los 

pines de E/S se muestra en la siguiente tabla: 
 
 
 



 
 
 

Conector de 10 pines (alimentación, E/S) 

Pin Color E/S Parámetro de 
Gecko Gripper 

1 Blanco E ENGAGE 
(sujeción) 

2 Marrón E DISENGAGE 
(separación) 

3 Verde S ULTRASONIC 
(ultrasónico) 

4 Amarillo S PART (pieza) 

5 Gris S PRELOAD 
(precarga) 

6 Rosa S PAD SERVICE 
(WEAR) (servicio 
de almohadillas 
(deterioro)) 

7 Azul PWR 
(alimentación) 

24VIN (entrada 
24 V) 

8 Rojo PWR 
(alimentación) 

GNDIN (entrada 
tierra) 

9 Naranja S ERROR 

10 Marrón E EARTH GND  
Imagen 37 Disposición de los pines del conector de 10 pines. 

 
Se puede considerar la asignación de pines E/S desde la perspectiva del 
dispositivo: en el caso de las entradas, el dispositivo espera recibir una señal de 
LOW (bajo) o HIGH (alto) de 24 V; en el caso de las salidas, el dispositivo enviará 
una señal de HIGH o LOW de 24 V al robot. 

 
Entradas 

ENGAGE (pin 1) (sujeción) 
Utilice el robot para enviar una señal de 24 V para mover las almohadillas a la posición 
de sujeción. Tenga en cuenta que el dispositivo solo moverá las almohadillas a la 
posición de sujeción si la señal DISENGAGE (separación) es LOW (bajo). Si ambas señales 
son HIGH, las almohadillas no se moverán. 
 
DISENGAGE (pin 2) (separación) 
Utilice el robot para enviar una señal de 24 V para mover las almohadillas a la posición 
DISENGAGE. Tenga en cuenta que el dispositivo solo moverá las almohadillas a la 
posición de separación si la señal ENGAGE es LOW. Si ambas señales son HIGH, las 
almohadillas no se moverán. 
 



CLEANING (pin 10) (limpieza)  
Este pin activa el sistema autónomo de limpieza piezoeléctrico opcional. Si utiliza el 
sistema de limpieza piezoeléctrico, se recomienda ajustar este pin en HIGH cuando el 
dispositivo no tiene una pieza, es decir, entre recogidas. Consulte el apéndice sobre el 
sistema de limpieza piezoeléctrico para obtener más información.  

 
Salidas 
 

ULTRASONIC (pin 3) (ultrasónico) 
En la salida ULTRASONIC se leerá HIGH si hay una pieza en una distancia menor que el 
valor establecido en la interfaz. De lo contrario, se leerá LOW al no haber ninguna pieza 
dentro de la distancia especificada.  
 
Ejemplo práctico: Recogida de objetos planos situados en una pila 
En estos pasos se detalla cómo puede utilizar la señal ULTRASONIC para programar que 
el dispositivo recoja objetos que están en una pila.  

1. Utilice la interfaz para establecer el rango ultrasónico a 50 mm. 
2. Durante la rutina de pick & place del robot, este pasa por encima de la pila. Si la 

salida ULTRASONIC es LOW, el robot puede acercarse rápidamente a la pila, ya 
que la salida ultrasónica indica que el dispositivo de agarre no está dentro del 
rango (50 mm). 

3. Cuando la salida ULTRASONIC pasa a HIGH, el dispositivo ha detectado un objeto 
dentro de 50 mm. El robot debe reducir la velocidad para permitir a Gecko 
Gripper realizar su acción de recogida y sacar el objeto de la pila. 

4. El robot finaliza su movimiento pick & place. La próxima vez que el robot recoja 
un objeto de la pila, el dispositivo de agarre será capaz de compensar de forma 
dinámica el cambio de altura de la pila. 

 
PARTS PRESENCE (pin 4) (presencia de piezas) 
En la salida PARTS PRESENCE se leerá HIGH si el dispositivo detecta que se ha recogido 
un objeto. Se leerá LOW si el dispositivo no sujeta ningún objeto. Esta señal se puede 
utilizar para confirmar que el dispositivo ha recogido correctamente una pieza. 
 
Si se cae una pieza, se indicará como error en el registro de errores y el LED de las 
almohadillas («PAD») empezará a parpadear en naranja en el propio dispositivo. 
 
PRELOAD (pin 5) (precarga) 
En la salida PRELOAD se leerá HIGH si la fuerza de precarga que ejerce el dispositivo es 
superior al valor establecido en la interfaz. De lo contrario, en la salida PRELOAD se leerá 
LOW. De la fuerza de precarga que ejerce Gecko Gripper depende la distancia hasta la 
que se mueve el brazo del robot hacia el objeto.  
 
Ejemplo práctico: Carga previa para recoger un objeto 
En estos pasos se detalla cómo puede utilizar la señal PRELOAD para controlar la fuerza 
de agarre en el objeto que se va a recoger.  

1. Utilice la interfaz para establecer la precarga a 100 N. 



2. Durante la rutina de pick & place del robot, se supone que el robot desciende 
para aplicar una precarga y recoger el objeto. Mientras la salida PRELOAD es 
LOW, el robot debe continuar su movimiento hacia abajo. 

3. Cuando la salida PRELOAD pasa a HIGH, el dispositivo ha alcanzado o superado el 
umbral de precarga de 100 N. El robot debe parar su descenso, ya que ha 
aplicado la fuerza de precarga deseada para recoger el objeto. 

 
PAD SERVICE (pin 6) (servicio de almohadillas) 
En la salida de PAD SERVICE (también llamada «Wear» o deterioro) se leerá HIGH 
cuando las almohadillas geco comiencen a desgastarse. El operador debe plantearse la 
sustitución de las almohadillas geco en este momento.  
 
 
ERROR (pin 9) 
En la salida ERROR se leerá HIGH siempre que se produzca un error y se indicará en el 
registro de errores del dispositivo. Este evento estará acompañado por una luz LED 
naranja de error en la base del dispositivo. El registro de errores y los códigos de error 
se pueden recuperar a través de la interfaz (véase la sección 7.3.5). 

 
 

7.2. Comunicación a través de Ethernet TCP/IP 
 

El control del dispositivo mediante Ethernet permite el control dinámico y completo de 
los parámetros del mismo. La tabla que se muestra a continuación indica el listado 
completo de parámetros de entrada y salida que el usuario puede controlar en el modo 
Ethernet. 

 

Parámetro TCP/IP E/S Descripción 

Modo de dispositivo 
(Ethernet y E/S) 

E Modo de comunicación (Ethernet o E/S) 

Transmisión de datos en 
tiempo real 

E Activa y desactiva las lecturas de datos en tiempo real. 

Posición almohadillas 
(sujeción/separación) 

E Mueve las almohadillas geco para recoger o soltar en 
un pick & place. 

Guarda la configuración de 
E/S del dispositivo 

E Guarda los ajustes actuales en la memoria para el 
control E/S. 

Especificaciones de la fuerza 
de precarga 

E Ajuste para el sensor de precarga. Si el sensor de 
precarga lee un valor superior a este ajuste, la salida 

E/S de fuerza de precarga pasa a HIGH. 

Especificaciones del rango 
ultrasónico 

E Configuración para el sensor ultrasónico. Si el sensor 
ultrasónico detecta que un objeto está más cerca que 

este ajuste, la salida E/S del sensor de rango 
ultrasónico pasa a HIGH. 

Activar limpieza E Activa el sistema autónomo de limpieza piezoeléctrico 
(solo para los dispositivos con el sistema 



piezoeléctrico incluido). 

Tiempo de limpieza (ciclo 
único) 

E El tiempo de limpieza para un ciclo único del sistema 
autónomo de limpieza piezoeléctrico. 

Fuerza de precarga alcanzada  S Se establece en HIGH si la fuerza de precarga es 
superior a la especificación de fuerza de precarga, de 
lo contrario es LOW, ya que la fuerza de precarga es 

inferior a la especificación. 

Presencia de piezas S En la salida de presencia de piezas se leerá HIGH si el 
dispositivo detecta que ha recogido un objeto, y se 

leerá LOW si no lo ha hecho. 

Deterioro S En la salida de deterioro se leerá HIGH cuando las 
almohadillas geco comiencen a desgastarse. El 
operador debe plantearse la sustitución de las 

almohadillas geco cuando en la salida se lee HIGH. 

Error detectado S En la salida de error se leerá HIGH siempre que se 
produzca un error. Esto se acompaña de una luz LED 
naranja que indica error, junto con una entrada en el 

registro de errores del dispositivo que se puede 
recuperar a través de la interfaz de Windows o 

específica del robot. 

Código de error S Proporciona el número de código del error más 
reciente.  

Datos de fuerza de precarga  S Proporciona el valor actual del sensor de fuerza de 
precarga. 

Sensor del rango ultrasónico S Ofrece el valor actual del sensor del rango ultrasónico. 

Modo de dispositivo 
(Ethernet y E/S) 

E Modo de comunicación (Ethernet o E/S) 

Transmisión de datos en 
tiempo real 

E Activa y desactiva las lecturas de datos en tiempo real. 

Imagen 4 Parámetros TCP/IP de Gecko Gripper 

El dispositivo se puede controlar en el modo de Ethernet TCP/IP a través de las 
interfaces de usuario de robot de OnRobot, compatibles con los robots de Universal 
Robots, Fanuc y Kawasaki.  

 
 

7.3. Ajuste del punto central de herramienta  
 
El punto central de la herramienta Gecko Gripper no tiene desplazamiento de ejes X o Y 
con respecto al robot.  Por tanto, el punto central de la herramienta se encuentra a 185 
mm (dirección del eje z) de distancia de la cara de montaje del brazo robótico (véase la 
sección 9.1 para obtener las dimensiones del dispositivo).  

 
Asegúrese de que el plano del dispositivo está alineado con el plano del objeto que se 
agarra. Ajuste el valor del punto de la posición elevada del robot (desvío, cabeceo, 
balanceo) para que sea coplanario con la posición del objeto. 



 
Al recoger el objeto, el dispositivo debe moverse sobre el objeto hasta que se alcance la 
fuerza de precarga deseada o antes de que aparezca la parte inferior de las 
almohadillas, lo que ocurra primero. 
 
 

7.4. Manejo del dispositivo con la detección de colisión u otros sistemas de seguridad 
del robot  

 
Cuando se utiliza Gecko Gripper con un robot en el control de posición, se debe tener 
cuidado durante la fase de sujeción del objeto para no activar el sistema de detección 
de colisión del robot.  La fuerza máxima que el dispositivo tendrá que ejercer sobre un 
objeto es de 150 N para una adherencia total.  En función del tipo de robot y el objeto, 
es posible que se deba ajustar la configuración de colaboración o de colisión del robot 
para evitar que este se pare al entrar en contacto con el objeto.   

 
 
 

7.5. Caso práctico de Gecko Gripper: Recogida y colocación de un pequeño panel solar 

 
Al recoger y colocar un objeto con Gecko Gripper, respete los siguientes pasos: 

 
Paso 1: Antes de recogerlo, lleve al robot y al dispositivo a una posición elevada 

por encima del objeto.  Asegúrese de que el centro de gravedad del 
objeto se encuentra bajo el centro del dispositivo.  Asegúrese asimismo 
de que las almohadillas del dispositivo y el objeto son coplanarios, es 
decir, que no haya inclinación. 

 

 
Imagen 38 Posiciones elevadas incorrecta (izquierda y centro) y correcta (derecha). 

 
Paso 2: Cuando se vaya a recoger el objeto, mueva el dispositivo lentamente 

hacia el objeto (en este caso, hacia abajo) al mismo tiempo que se 



asegura de que las almohadillas de sujeción y la superficie del objeto son 
coplanarias.  

 

 
Imagen 39 Comprobación visual de que las almohadillas y la superficie del panel solar son coplanarias. 

 
Paso 3: Deje que el objeto entre en contacto con el dispositivo y acciónelo hasta 

que se consiga la fuerza de precarga deseada.  La fuerza de precarga se 
puede leer desde la interfaz del robot o de Windows.   

 
AVISO: La fuerza de precarga máxima para Gecko Gripper es de 150 N.  Es 

posible que se deba ajustar la configuración del robot para adecuarse a 
esta fuerza máxima. 

 
En caso de que la precarga adecuada no sea un motivo de preocupación 
(un objeto con poco peso, por ejemplo), el dispositivo se puede guiar de 
forma visual en el control de posición para que entre en contacto.  En 
cualquier caso, es importante asegurarse de que la carcasa del dispositivo 
no entra en contacto con el objeto,  ya que ello puede dañar el objeto y 
activar el procedimiento de seguridad ante colisión del robot. 

 



 
Imagen 40 Proximidad de la carcasa del dispositivo al objeto que se va a agarrar (en este caso, el panel solar) correcta (arriba) e 

incorrecta (abajo). 

 
Paso 4: Para liberar el objeto, siga las instrucciones específicas del tipo de 

comunicación que haya seleccionado: E/S o Ethernet. 
 
Si utiliza la comunicación por E/S, accione el canal E/S adecuado para 
DISENGAGE a HIGH (durante un segundo o menos) y, a continuación, a 
LOW.  De esta forma, se retraerán las almohadillas hacia el dispositivo. 
Una vez colocado el objeto, las almohadillas deben moverse hacia 
ENGAGE manteniendo de forma momentánea el canal adecuado de E/S 
en HIGH, para después volver a LOW para prepararse para la siguiente 
recogida.   
 
Si utiliza la comunicación por Ethernet, se puede obtener el mismo 
resultado estableciendo el paquete Ethernet adecuado en HIGH o LOW 
de forma similar al modo E/S. 
 
La colocación del objeto requiere que las almohadillas se retraigan. Cabe 
señalar que, durante la retracción de las almohadillas, el objeto reducirá 
la distancia entre la carcasa del dispositivo y la superficie sobre la que se 



coloca el objeto. Consulte la sección 9.1 para obtener más información 
sobre las dimensiones del dispositivo.  

 
 
 
  
 
 

  



8. Especificaciones de Gecko Gripper 
 

8.1. Especificaciones técnicas 
 

8.1.1. Dimensiones de Gecko Gripper 
 

Las dimensiones de Gecko Gripper se ilustran a continuación en unidades métricas 
(mm).  
 

 
Figure 41 Dimensiones frontales y laterales de Gecko Gripper. 

 

 
Figura 42 Dimensiones de la cara de agarre (inferior) de Gecko Gripper. 



 

 
Figura 43 Dimensiones de la cara de montaje (superior) de Gecko Gripper. 

 

8.2. Condiciones del entorno y operativas 

 
Condición Valor 

mínimo 
Valor 

óptimo 
Valor 

máximo 
Notas 

Temperatura 0 C N/A 50 C Almacenamiento hasta 60 C 

Características 
de la superficie 

Acabado 
mate 

Muy pulido N/A Las superficies más lisas 
requieren menos fuerza de 
precarga para alcanzar la fuerza 
de carga útil deseada. 

Imagen 5 Condiciones del entorno y operativas para Gecko Gripper. 

 

8.3. Especificaciones mecánicas 
 

8.3.1. Especificaciones del dispositivo 
Especificaciones o 

características 
Valor objetivo 

Carga útil máxima (kg) 
          Adhesión nativa 
          Después del factor de 
seguridad (x2) 
          Con sistema de limpieza 

Acero pulido/Acrílico/Vidrio/Chapa metálica  
8,2/8,1/6,6/6,1 
8,2/8,1/6,6/6,1 
1,6/1,6/1,3/1,3 

Peso del dispositivo 2,4 kg 

Precarga sugerida necesaria 
para máxima adhesión 

125 N (una reducción de la precarga tiene como 
resultado una reducción de la adhesión. Consulte 

la sección 9.4 para obtener más información). 
Fuerza de precarga máxima 150 N. 

Tiempo de separación 500 ms 



Certificaciones 
FCC Part 15 / Canada ISED 

CE - EMC, CE - LV 

Grado de protección IP 54 

Tratamiento de errores LED e interfaz gráfica 

Interfaz de usuario 

Consola de programación (Universal Robots, 
Kawasaki, Fanuc) 
PC con Windows 

¿Sostiene la pieza en caso de 
fallo eléctrico? Sí 

Opciones de comunicación 
E/S digital 

Ethernet TCP (protocolo personalizado) 

Temperatura de 
funcionamiento 0 °C - 50 °C 

Requisitos de alimentación 
Pico: 24 V DC, 0,8 A 
RMS: 24 V DC, 0,5 A 

Opciones de cables y 
alimentación 

2 cables: alimentación y E/S, accionador del 
sistema piezoeléctrico (M12) 

3 cables: alimentación, Ethernet, accionador del 
sistema piezoeléctrico (M12) 

Imagen 6 Especificaciones de Gecko Gripper. 

 
8.3.2. Especificaciones de las almohadillas 

 
Especificaciones o características Valor objetivo 

Sensor de presencia de piezas Sí (ultrasónico) 

Material de las almohadillas Mezcla patentada de silicona 

Propiedades de deterioro Depende de la rugosidad de la superficie 

Mecanismo de fijación de las almohadillas Magnético 

Intervalo de reemplazo 
50.000-100.000 ciclos (depende de la 

superficie) 

Sistema autónomo de limpieza Piezoeléctrico (opcional) 

Intervalo de limpieza autónoma y % de 
recuperación 15 s: 3 % / 2 min: 5 % / 15 min: 15 % (máx.) 

Sistema de limpieza manual Rodillo de silicona 
Intervalo de limpieza manual y % de 
recuperación Variable / 100 % 

Imagen 7 Especificaciones de las almohadillas de Gecko Gripper. 

8.3.3. Especificaciones del sensor de precarga 
 
El sistema del sensor de precarga se basa en la tecnología del sensor Tekscan 
piezorresistivo.  Los datos sobre el sensor basal se pueden encontrar en el sitio web de 
Tekscan (a continuación), pero cada sistema de sensores se calibra según el dispositivo. 

 
https://www.tekscan.com/flexiforce-load-force-sensors-and-systems 

 
8.3.4. Sensor del rango ultrasónico 

https://www.tekscan.com/flexiforce-load-force-sensors-and-systems


 
El sensor de presencia de piezas y del rango se basa en una tecnología de sensor 
ultrasónico. Puede encontrar más información en el siguiente enlace: 
 

https://cdn.automationdirect.com/static/specs/prox18mmultrauk6.pdf 
 
 

8.4. Selección de una fuerza de precarga adecuada 
 

Elegir una fuerza de precarga adecuada es fundamental para un funcionamiento óptimo 
del dispositivo y depende en gran medida de los detalles de la aplicación específica. Por 
ejemplo, el material del objeto, los movimientos robot-objeto y las condiciones del 
entorno afectarán a la cantidad de fuerza de precarga necesaria. 

 

https://cdn.automationdirect.com/static/specs/prox18mmultrauk6.pdf


8.4.1. La fuerza de adhesión aumenta con la fuerza de precarga (en función del 
material) 

 
Gecko Gripper funciona mejor en superficies muy pulidas que permiten el máximo 
contacto entre las almohadillas adhesivas y la superficie del objeto. Cuanto menos lisa 
sea la superficie, más fuerza de precarga se necesita para agarrar el objeto. Las 
superficies mate deben considerarse el límite máximo de rugosidad que el dispositivo es 
capaz de agarrar.  
 

 
Imagen 44 La fuerza de carga útil para una fuerza de precarga determinada depende de la uniformidad o rugosidad del objeto. 

Las especificaciones de adhesión asumen que el centro de gravedad del objeto es 
equidistante con las almohadillas del dispositivo. Si el centro de gravedad del objeto 
no está centrado o se aplican momentos al objeto, se puede producir una disminución 
de la fuerza del dispositivo provocando que se caigan los objetos. 
 
La fuerza de precarga óptima para la aplicación concreta dependerá de la rugosidad de 
la superficie del objeto y debe determinarse de manera experimental en las condiciones 
de manejo específicas que usted tenga. 
 
Gecko Gripper también puede recoger materiales flexibles, siempre que estos sean lisos 
y resistentes (que no se deformen); por ejemplo, el papel de aluminio y el envoltorio 
plástico. La fuerza de precarga requerida para recoger estos materiales depende tanto 
de la rugosidad de la superficie como de la rigidez del soporte o refuerzo por donde se 



agarran dichas superficies. La fuerza de precarga óptima debe determinarse de forma 
experimental.  
 

 

8.5. Ubicación de la recogida y límites del movimiento de la carga útil 
 
Los usuarios también deben tener en cuenta la fuerza g y otras fuerzas que actúan sobre 
la pieza agarrada y que podrían superar la fuerza de agarre de Gecko Gripper. La 
aplicación de un momento al objeto puede dar lugar a que este se desprenda de las 
almohadillas y pueda caerse. Este problema se magnifica cuando la huella del objeto 
excede en gran medida la huella del dispositivo. 
 

  



9. Mantenimiento del dispositivo 
 

9.1. Descripción y planificación del mantenimiento 
 

Las almohadillas Gecko Gripper están fabricadas con una silicona de fundición de 
precisión o una película de poliuretano con una microestructura geco. El contacto con 
objetos afilados puede dañar la superficie de la almohadilla y afectar a su 
funcionamiento. El rendimiento de Gecko Gripper se maximiza cuando las almohadillas 
están limpias y secas.  Las almohadillas pueden acumular polvo, por lo que es mejor usar 
Gecko Gripper en un ambiente limpio o establecer un programa de limpieza rutinario. 

 
 
 
 
 
 
 
 
 
 
 
 
 

9.2. Limpieza de las almohadillas 
 

Para limpiar las almohadillas manualmente, revíselas y utilice el rodillo adherente que se 
proporciona para eliminar el polvo o los residuos de la superficie.  

 
Imagen 45 Limpieza manual de las almohadillas con el rodillo adherente. 

Pieza Descripción del mantenimiento Frecuencia 

Almohadillas  Limpieza rutinaria: 
 

• Manual: rodillo adherente  

• Programada: estación de 
limpieza 

• Autónoma: sistema 
piezoeléctrico  

 
 
Sustitución: 

En función de las 
condiciones de 
funcionamiento. 
Recomendaciones: 

• Manual: semanal 

• Programada: diaria  

• Autónoma: cada ciclo, 
si es posible 

 
Cada 50.000 - 100.000 
ciclos 

Conectores Sustitución debido a pines doblados Según sea necesario 



Si se utiliza el sistema de limpieza piezoeléctrico opcional, consulte el apéndice para el 
sistema de limpieza piezoeléctrico. 
  

9.3. Sustitución de las almohadillas 
 

Las almohadillas de Gecko Gripper están diseñadas para durar 50.000 - 100.000 ciclos en 
condiciones normales de funcionamiento. Si parece que las almohadillas no agarran 
correctamente, incluso después de una limpieza rutinaria (véase la sección 10.2), se 
recomienda sustituirlas completamente. 
 
Para sustituir las almohadillas del dispositivo, utilice la herramienta de extracción de 

almohadillas que se proporciona. 
 
Paso 1: Si utiliza el sistema de limpieza piezoeléctrico, asegúrese de que la fuente 

de alimentación está desconectada o apagada temporalmente. 
 
Paso 2: Mueva las almohadillas a la configuración de extrusión máxima de tal 

manera que las almohadillas estén completamente expuestas y visibles. 
 

 
Imagen 46 Las almohadillas de Gecko Gripper en su posición de extrusión máxima y la herramienta de extracción de 

almohadillas. 

 
Paso 3: Inserte el borde de la herramienta de extracción entre la placa plateada 

brillante de las almohadillas y la placa de apoyo mate. Haga palanca con 
la herramienta de extracción en la carcasa del dispositivo para separar la 
almohadilla usada. Repita este procedimiento con todas las almohadillas. 

 



 
Imagen 47 Haga palanca con la herramienta de extracción para sustituir las almohadillas desgastadas. 

Paso 4: Para instalar las nuevas almohadillas de repuesto, alinee la hendidura de 
la almohadilla con la pestaña en el orificio de montaje. Presione la 
almohadilla hacia el dispositivo hasta que no haya ningún hueco entre la 
placa de la almohadilla plateada brillante y la placa de apoyo. 

 

 
Imagen 48 Instalación de las nuevas almohadillas de recambio, alineando la hendidura de la placa de montaje con la pestaña de 

la almohadilla de repuesto. 

Paso 5:  Envíe las almohadillas a OnRobot A/S en Los Ángeles para su sustitución.  
  



10. Piezas de repuesto y accesorios 
 

Categoría Número 
de la 
pieza 

Nombre de la pieza Descripción 

Dispositivo PGG-V5 Gecko Gripper V5 
Gecko Gripper versión 5, con sistema de 
limpieza piezoeléctrico 

Almohadillas PGG-P-4 

Conjunto de cuatro 
almohadillas de Gecko 
Gripper sin sistema de 
limpieza piezoeléctrico 

Conjunto de cuatro almohadillas de 
Gecko Gripper sin sistema de limpieza 
piezoeléctrico 

Cable 
CBL-10W-
8M Cable Turck, 10 hilos, E/S 

Cable, 10 hilos, doble terminación 
(conector hembra recto y conector 
macho recto), conectores M12 Eurofast 

Cable 
CBL-8W-
RJ45-5M 

Cable Turck, 8 hilos, 
Ethernet RJ45 

Cable, 8 hilos, Ethernet, Macho, M12 de 
5 m 

Hardware MB-1 
Pernos de montaje para el 
dispositivo 

Tornillo Allen de acero inoxidable, 
M6X1.0 y 80 mm de longitud 

Herramienta HK-5 

Llave Allen para montaje 
del robot, 5 mm, 9 pulgadas 
de longitud total 

Llave Allen para montaje del robot, 5 
mm, 9 pulgadas de longitud total 

Herramienta PGG-RT-1 
Herramienta de extracción 
de almohadillas 

Espátula con borde biselado, ancho de 
hoja 1-1/4" y grosor 0,075" 

USB 
PGG-USB-
1 

Unidad USB OnRobot A/S 
con guías e interfaz gráfica 
de usuario 

Memoria USB con guías e interfaz 
gráfica de usuario 

Fuente de 
alimentación 

ADP-24V-
90 

ADAPTADOR DE CORRIENTE 
AC/DC de 24 V y 90 W 

ADAPTADOR DE CORRIENTE AC/DC de 
24 V y 90 W 

Inicio rápido QS-GG-1 Guía de inicio rápido  

Solo Gecko Gripper con sistema de limpieza piezoeléctrico 
Dispositivo 
(sistema 
piezoeléctrico) PGG-V5-P 

Gecko Gripper V5 con 
sistema de limpieza 
piezoeléctrico 

Gecko Gripper versión 5 con sistema de 
limpieza piezoeléctrico 

Cable 
(piezoeléctrico) 

CBL-4W-
8M 

Cable Turck, 4 hilos, 8 m, 
para el controlador del 
sistema piezoeléctrico Cable, 4 hilos, M12, macho/hembra, 8 m 

Controlador 
del sistema 
piezoeléctrico PGG-PZD-1 

Electrónica del controlador 
del sistema piezoeléctrico 

Electrónica del controlador del sistema 
piezoeléctrico 

Opcional 
Placa 
adaptadora ADP-1 

Placa adaptadora para robots Kawasaki y 
Fanuc 

Placa adaptadora para 
robots Kawasaki y Fanuc 

Imagen 8 Piezas y descripciones de Gecko Gripper 

 
 

  



11. Solución de problemas  
 

11.1. Tratamiento de errores   
 
Los eventos y errores inesperados los registra el programa del dispositivo durante un 
recorrido, y se pueden guardar en un archivo local si se ejecuta la interfaz gráfica de usuario 
(véase la sección 7.3.5 sobre el tratamiento de errores). 

 

11.2. Estados LED   
 

En el dispositivo hay LED indicadores de estado correspondientes a la alimentación 
(«Power»), los errores generales («Error»), el estado de las almohadillas («Pads») y la 
comunicación («Comms»).  Los indicadores LED y su significado se muestran en la siguiente 
tabla: 
 

Nombre del LED 
y color 

Color fijo Parpadeo lento Parpadeo rápido 

Alimentación 
Verde 

Alimentación 
conectada 

N/A N/A 

ERROR  
Rojo 

N/A Advertencia (errores 
internos): el dispositivo 
necesita mantenimiento. 
Compruebe el registro de 
errores para obtener más 
información. 

Error grave: el dispositivo 
debe detenerse 
inmediatamente e 
investigarse. 

Almohadilla 
Naranja 

N/A Una pieza se ha caído. Las piezas se han caído 
varias veces y se ha 
actualizado el registro de 
errores. 

Comunicaciones 
Azul 

Comunicaciones 
conectadas 

N/A N/A 

Imagen 9 Tabla de indicadores LED y su significado. 

 

12. Garantía  
 
Consulte el sitio web de OnRobot A/S para obtener información sobre la garantía o envíe 
un correo electrónico a info@onrobot.com.  
 

mailto:info@onrobot.com


13. Contacto  
 

OnRobot A/S  
Teglvaerksvej 47H  
5220 Odense, Dinamarca  
info@onrobot.com  
 

14. Declaraciones y certificados 
 

Certificaciones de Gecko Gripper: 
• FCC Part 15 / Canada ISED 
• CE - EMC, CE - LV 
• Diseñado para el grado de protección IP54 

mailto:info@onrobot.com
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